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01.0 Introduction

Thank you for purchasing ProJet™ 3-D modeler system. We pride ourselves in our ability to offer customers three dimensional modeling
solutions. The 3D System team is confident your system will provide many years of service.

1.1 About this Guide
1.2 Copyright
1.3 Useful Documents
1.4 What's Inside
1.5 Features and Benefits
® 1.5.1 Description and Definitions
1.6 ProJet™ Systems Software
1.7 Packaging

1.6 ProJet™ Systems Software

To install ProJet™ series upgrades, click on ProJet™ Systems Software to download the software and the software release notes that provide
detailed installation instructions.

1.1 About this Guide

This guide describes how to create finished parts using the ProJet™ 3-D Modeler. It also provides user's with an understanding of key features,
system requirements, and operating procedures.

Should additional questions arise, consult Section 11.0 Troubleshooting of this guide. If further assistance required, contact 3D Systems
Technical Support or visit http://www.3dsystems.com/ Web Site.

1.2 Copyright

© 2011 by 3D Systems, Inc. All rights reserved. Subject to change without notice. This document is copyrighted and contains proprietary
information that is the property of 3D Systems, Inc. The licensed user, in the name of whom this document is registered (the "Licensed User")
does not have the right to copy, reproduce, or translate this document in any way or to any media without the prior written consent of 3D Systems,
Inc. No copies of the document may be sold or given to any person or other entity.

ProJet™is a trademark and the 3D logo and VisiJet® are registered trademarks of 3D Systems, Inc.

Improvements

3D Systems may (but shall not be obligated to) make improvements to this document from time to time. However, the Licensed User
acknowledges that at any time after the expiration of the date of issuance, 3D Systems may institute a periodic charge or fee payable by the
Licensed User in return for ongoing receipt of improvements. It is the responsibility of the Licensed User to provide 3D Systems with current
information as to its name and address. The Licensed User also undertakes to notify 3D Systems promptly in the event that it considers any of the
data contained in this document to be incomplete or erroneous in any respect, in connection with Licensed User's particular use or generally.

FCC Notice

This equipment has been tested and found to comply with the limits for a class A digital device, pursuant to Part 15 of the FCC Rules. These limits
are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may
cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in
which case the user will be required to correct the interference at his own expense.

Changes or modifications not expressly approved by 3D Systems could void your authority to operate this equipment.

Limitations of Warranty and Liability

This information is provided by 3D Systems for the convenience of its customers. It is believed to be reliable, but NO REPRESENTATIONS,
GUARANTEES, OR WARRANTIES OF ANY KIND ARE MADE AS TO ITS ACCURACY, FITNESS FOR A PARTICULAR USE, OR THE
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http://www.3dsystems.com/

RESULTS TO BE OBTAINED THEREFROM. The information is based in whole or in large part on laboratory work and does not necessarily
indicate performance in all conditions. Notwithstanding any information provided by 3D Systems or its affiliates, the customer remains fully
responsible for determining which federal, state, or local laws or regulations, or industry practices are relevant to activities in which it engages, as
well as assuring that those laws, regulations, or standards are complied with under actual operating conditions, and 3D Systems undertakes no
responsibility in these areas.

IN NO EVENT WILL 3D Systems BE RESPONSIBLE FOR DAMAGES OF ANY NATURE, INCLUDING SPECIAL OR CONSEQUENTIAL
DAMAGES, RESULTING FROM THE USE OF OR RELIANCE UPON THIS INFORMATION. THE CUSTOMER ASSUMES ALL RISK
RESULTING FROM THE USE OF THIS INFORMATION. Customers use of the materials that follow is an acknowledgment of its agreement to
the foregoing. Any customer not wishing to be bound should return this material to 3D Systems. Nothing contained herein is to be considered as
permission, recommendation, nor as an inducement to practice any patented invention without permission of the patent owner.

1.3 Useful Documents

The documents listed below will help get the most out of your system, To access, click on the document title.

ProJet™ 3-D Modeling Client Online Help: Run the client software, select Help > Help Topics in the modelers window or in Build Preview window
to launch the client online help. The online help provide detailed instructions on how to use the client software to setup, run, and manage build
jobs.

PROJET 3-D Modelers Quick_Reference Guide.pdf: Download to have quick reference on the control panel functions, how to load / remove
cartridges, and how to run a test build.

VisiJet® Material Handling and Post-Processing Guide: This document has everything needed to guide you in safely handling and disposing of
VisiJet® material, including relevant regulatory guidelines for material disposal worldwide. It also provides information on how to clean parts once
the build process is completed.

Projet™ 3-D Modelers Facility Requirements Guide. This guide provides the dimensional data that is required when the 3D System's Field
Service Engineer installs the modeler. Clck on the part number to view a copy for reference.

VisiJet® Material Safety Data Sheets (MSDS's): Ensure everyone who handles VisiJet™ materials is familiar with MSDS's and follows the safety

guidelines. To order extra copies of MSDS's, request the appropriate document part numbers are located on the bottom left-hand corner of the
MSDS.

1.4 What's Inside

Safety: Read prior to handling VisiJet® Materials or operating the modeler system. The safety sections inform you of handling the material
properly and avoid damage and injury when operating the modeler. For more detailed material safety information, refer to VisiJet® Material
Handling Guide.

System Requirements: Provides electrical requirements prior to plugging in your modeler for operation. For more detailed facility requirements
information, see the ProJet™ 3-D Modelers Facility Requirements Guide.

Familiarization: Provides a brief description of the modeler system.

Modeler Setup: Provides information on preparing the 3-D modeler for builds using the software, and how to send test and demo builds to the
modeler from your computer. Also refer to your online help for software instructions.

Operations: Describes loading and running the modeler; start and stop build jobs; monitor and control build jobs; unload build parts; and
disposing waste material.

Error Messges: Defines the error messages you may see on the modeler's LCD and provide the actions to take.
Finishing:Provides information on finishing models.

Maintenance: List modeler maintenance procedures which must be done to ensure high part yield and low modeler down time. Semi-annual
preventive maintenance requires a certified 3D Systems Technical Support Representative.

Troubleshooting: If problems occur with the modeler, look for solutions in this section first. It describes some common problems which can
occur and suggests corrective actions.

Technical Support: List of contact numbers of sale and support personnel for your modeler system.

1.5 Features and Benefits
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ProJet™ HD3000 prints precision, durable plastic parts ideal for functional testing, design communication,
rapid manufacturing, rapid tooling and more. It features selectable resolution choices for speed and quality.
Printing Mode: High Definition(HD), Ultra High Definition (UHD)

Net Build Volume (xyz): HD Mode: 298 x 185 x 203mm (11.75 x 7.3 x 8 inches); UHD Mode: 127 x 178 x
152mm (5 x 7 x 6 inches)

Resolution (xyz): *HD Mode: 328 x 328 x 606 DPI (xyz); 40u layerslJHD Mode: 656 x 656 x 800 DPI (xyz); 32u
layers

VisiJet® Materials: Part Materials: EX200, SR200, HR200; Support Material: S100

Part Stacking and Nesting: features part stacking and nesting capability in both build modes. The user can
now utilize the entire build volume by stacking parts vertically in the z-direction to fill up the entire build envelop
with parts. The user can control the space between layers to minimize support material usage and build time.
Now, hours can be saved by stacking parts and submitting single, long builds overnight and weekends.

ProJet™ HD3000plus features a 60% expanded high definition build envelope and advanced print detail
output. A new 16 micron print resolution delivers exceptional hard plastic parts with unmatched micro-detail and
surface quality.

Printing Mode: High Definition (HD), Ultra High Definition (UHD), Xtreme High Definition (XHD)

Net Build Volume (xyz): HD Mode: 298 x 185 x 203mm (11.75 x 7.3 x 8 inches); UHD Mode: 203 x 178 x
152mm (8 x 7 x 6 inches);

XHD Mode: 203 x 178 x 152mm (8 x 7 X 6 inches)

Resolution (xyz): HD Mode: 328 x 328 x 606 DPI; 40y layerslJHD Mode: 656 x 656 x 800 DPI; 32y layers;
XHD Mode: 656 x 656 x 1600 DPI ; 16 layers

VisiJet® Materials: Part Materials: EX200, SR200, HR200; Support Material: S100

Email Notification: Provides email notification to the user when their job begins, completes, aborts and if the
system is low on material at any time during their build. Users can set their defaults and make changes as to
what emails they will receive via the Job Options window.

ProJet™ CPX3000 mass produces 100% wax patterns with unmatched surface quality, extreme fine detail and
exceptional precision. RealWax patterns are ideal for casting jewelry, apparel, micro-detail medical instruments
and devices, medical implants, electrical components, figurines, replicas, collectables and more.

Printing Mode: High Definition(HD), Xtreme High Definition (XHD)

Net Build Volume (xyz): HD Mode: 298 x 185 x 203mm (11.75 x 7.3 x 8 inches); XHD Mode: 127 x 178 x
152mm (5 x 7 x 6 inches)

Resolution (xyz): *HD Mode: 328 x 328 x 700 DPI (xyz); 36 layersXHD Mode: 656 x 656 x 1600 DPI (xyz);
16p layers

VisiJet® Materials: Part Materials: CPX200 Wax; Support Material: S200

Part Stacking and Nesting: features part stacking and nesting capability in both build modes. The user can
now utilize the entire build volume by stacking parts vertically in the z-direction to fill up the entire build envelop
with parts. The user can control the space between layers to minimize support material usage and build time.
Now, hours can be saved by stacking parts and submitting single, long builds overnight and weekends.

ProJet™ CPX3000plus features a 60% expanded high definition build envelope with up to 20% increased print
speed. A new 20 micron high resolution option delivers exceptional wax patterns with smooth surface quality
and fine feature detail in less time.

Printing Mode: High Definition (HD), Ultra High Definition (UHD), Xtreme High Definition (XHD)

Net Build Volume (xyz): HD Mode: 298 x 185 x 203 (11.75 x 7.3 x 8 inches); UHD Mode: 203 x 178 x 152mm
(8 x 7 x 6 inches);

XHD Mode: 203 x 178 x 152mm (8 x 7 x 6 inches)

Resolution (xyz): HD Mode: 328 x 328 x 700 DPI (xyz); 36u layersJHD Mode: 656 x 656 x 1300 DPI; 20u
layers; XHD Mode: 656 x 656 x 1600 DPI, 16y layers

VisiJet® Materials: Part Materials: CPX200 Wax; Support Material: S200

Email Notification: Provides email notification to the user when their job begins, completes, aborts and if the
system is low on material at any time during their build. Users can set their defaults and make changes as to
what emails they will receive via the Job Options window.

ProJet™ CP3000 mass produces 100% wax patterns with smooth surface quality and exceptional precision,
supporting almost unlimited applications capabilities. RealWax patterns are ideal for general foundry casting
applications such as medium-sized to large mechanical parts for engines, pneumatics, aerospace, energy
production and delivery, custom manufacturing equipment, restorations and other heavy equipment.

Net Build Volume (xyz): 298 x 185 x 203mm (11.75 x 7.3 x 8 inches)

Resolution (xyz): 328 x 328 x 700 DPI; 36y layers

VisiJet® Materials: Part Materials: CP200 Wax; Support Material: S200

Part Stacking and Nesting: features part stacking and nesting capability in both build modes. The user can
now utilize the entire build volume by stacking parts vertically in the z-direction to fill up the entire build envelop
with parts. The user can control the space between layers to minimize support material usage and build time.
Now, hours can be saved by stacking parts and submitting single, long builds overnight and weekends.



ProJet™ SD3000 prints high definition, durable plastic parts for engineering and mechanical design
applications including functional testing, form and fit verification, rapid prototyping, design communication, rapid
tooling and more.

Net Build Volume (xyz): 298 x 185 x 203mm (11.75 x 7.3 x 8 inches)

Resolution (xyz): 328 x 328 x 606 DPI (xyz)

VisiJet® Materials: Part Materials: EX200 (natural) & SR200 (Blue, Natural & Gray); Support Material: S100

ProJet™ DP3000 accurately, consistently and economically manufactures precision wax-ups for dental
professionals. The system can generate hundreds of units each cycle. The wax-ups have a smooth surface
finish and can be cast or pressed with conventional techniques. The large build volume and optional part
stacking and nesting capabilities enable unattended operation ideal for high-volume production.

Printing Mode: High Definition (HD); Ultra High Definition (UHD)

Net Build Volume (xyz): HD Mode: 298 x 185 x 203mm (11.75 x 7.3 x 8 inches); UHD Mode: 203 x 178 x
152mm (8 x 7 x 6 inches)

Resolution (xyz): *HD Mode: 328 x 328 x 606 DPI; UHD Mode:328 x 328 x 606 DPI

VisiJet® Materials: Part Materials: DP200; Support Material: S100

Email Notification: Provides email notification to the user when their job begins, completes, aborts and if the
system is low on material at any time during their build. Users can set their defaults and make changes as to
what emails they will receive via the Job Options window.

ProJet™ MP3000 can produce any size model with smooth surfaces. Multiple models can be built at one time.
Works with any compatible intraoral, plaster or impression scanner. This Printing System is designed for use in
laboratories with extended unattended operation, same day processing - helps you reduce time and cost.
Printing Mode: High Definition (HDX); Ultra High Definition (UHD)

Net Build Volume (xyz): HDX Mode: 298 x 185 x 203mm (11.75 x 7.3 x 8 inches); UHD Mode: 127 x 178 x
152mm (5 x 7 x 6 inches)

Resolution (xyz): *HDX Mode: 328 x 328 x 606 DPI; UHD Mode: 656 x 656 x 800 DPI

VisiJet® Materials: Part Materials: MP200; Support Material: S100

¢ 1.5.1 Description and Definitions

1.5.1 Description and Definitions

Depending on the model of the ProJet 3000 3-D Production System, your system features different types of build styles to meet a variety of model
making applications. Please refer to Features and Benefits that will describe your extended choices for your particular system.

Description and Definitions

® The High Definition (HD) Mode allows the user rapid model making capability on a full platform. This mode produces high quality parts
for concept models, verification designs and patterns for casting.

® The Ultra High Definition (UHD) Mode allows the users to build extremely high resolution parts with exceptional surface finish and
superior accuracy. Models build in UHD mode are typically used for show models, fit testing and direct manufacturing using patterns for
investment casting of jewelry and small components.

® Expanded UHD Mode: Provides the user with an Expanded Ultra High Definition (UHD) mode build envelope.

* Expanded XHD Mode: Provides the user access to the new Extreme High Definition (XHD) Mode that features a new print resolution
with the same expanded build envelope available in UHD.

®* Email Notification: Provides email notification to the user when their job begins, completes, aborts and if the system is low on material
at any time during their build. Users can set their defaults and make changes as to what emails they will receive via the Job Options
window.

Part Stacking and Nesting

The new ProJet 3-D Production System, features part stacking and nesting capability in both build modes. The user can now utilize the entire
build volume by stacking parts vertically in the z-direction to fill up the entire build envelop with parts. The user can control the space between
layers to minimize support material usage and build time. Now, hours can be saved by stacking parts and submitting single, long builds overnight
and weekends.

Bounding Box Display Added to Print Preview

A few new features have been added to Print Preview to allow it to handle up to two gigabytes of part data on a single build.

®* The Bounding Box Display has been added to Print Preview to allow file sizes that were previously too large for Print Preview to load
successfully. The Bounding Box Display only displays the bounding extents of a given geometry and does not try to resolve the triangles
required to display an entire geometry. See Section 8.1 Preview Build Job.



® Job Submission Checking has also been added. Both the 3-D Modeling Client and Print Preview now check to make sure that the
maximum allowable accumulated build file size on the machine is not exceeded during job submission. The maximum threshold for job
submission is roughly two gigabytes or 40,000,000 triangles. See Section 8.3 Submit a Build Job
The new ProJet™ HD 3000plus production system introduces new enhancements including an expanded build envelope for the UHD

build mode, the new XHD build mode and email notification.

1.7 Packaging

Packaging
Do not damage or discard any packaging materials or carton(s). If the modeler needs to be returned to the manufacturer, it should be shipped in

it's original packaging. If other packaging is used, the customer will be responsible for any shipping damages that may occur.

Only Certified/Qualifed Service Personnel can install the 3-D moder.

02.0 Safety Symbols & Definitions

UV Radiation Hazard: Invisible UV radiation is accessible in the vicinity of this sign or behind the panel. Radiation can cause eye injury.
Access panels are for service only and should be opened only by certified service personnel.

Electrical Shock Hazard: High voltage electricity is accessible in the vicinity of this sign or behind the access panel. High
voltage can cause severe burns or death. Access panels are for service only and should be opened only by certified service

personnel or trained maintenance personnel.

Hot Surface Hazard: A hot surface is accessible in the vicinity of this sign or behind the access panel. Avoid contact. Hot surfaces can
cause severe burns. Access panels are for service only and should be opened only by certified service personnel or trained

maintenance personnel.

Harmful Irritant Warning: Indicates that skin or eye irritation could result while exposed to a
chemical composition.

Caution: Indicates something may happen that could cause loss of data, damage to equipment, or personal injury.

03.0 Safety Guidelines



Before using the modeler, your company should have a safety program in place. The safety program should:

® Label and point out hazardous equipment, materials, and procedures.

® Explain what to do in case of an emergency.

® Provide information about hazards of equipment and materials in the form of Material Safety Data Sheets (MSDSs). The MSDSs are
provided with all materials supplied by 3D Systems.

® 3.1 General
® 3.2 Electrical
¢ 3.3 Ultraviolet (UV) Light

3.1 General

The modeler is designed with built in safety features, improper use and malfunctions can cause injury to personnel. To prevent unsafe operation,
the modeler will automatically shut down if unsafe conditions are detected.

Follow these safety guidelines when operating the modeler:

Read and follow all modeler instructions.

Follow all safety rules and heed all cautions and warnings in this guide.

Do not attempt to open chamber door while build in progress.

Do not use any material without reviewing the Material Safety Data Sheets (MSDS).

Dress power and communication cables behind modeler to prevent tripping.

Do not attempt to access, service, or adjust modeler components. Do not attempt to perform any maintenance procedures unless
specifically trained to do so.

Operators are trained to operate system and perform all necessary tasks to create a part.

Certified service personnel are those who completed the 3D Systems service training package and certified to perform service tasks. Certification
may occur at different levels, and service providers should only perform tasks they are authorized and certified to complete.

Do not ignore warning signs posted during modeler service operations.
If an error message appears on the modeler's LCD refer to Section 10.0 Error Messages within this guide before resuming operation.
To prevent potential skin-irritation and sensitization due to contact with waste material, follow all guidelines within Build Material Safety.

To prevent pinch and crush injuries to the hand, use caution when replacing platform inside the build chamber.

3.2 Electrical

DANGER
Hazardous voltage exists inside the modeler. Injury or death from electrical shock can result if you remove the printer's
external panels. Panels should only be removed for service by trained and certified 3D Systems Technical Support
personnel.

To prevent electrical shock, the modeler will not operate unless external panels are installed. Verify facility's electrical service rating before you
connect power to the modeler.

3.3 Ultraviolet (UV) Light

CAUTION
Hazardous UV radiation exists inside the modeler build chamber during build job. Eye injury or blindness can result if
chamber door is opened while a build job is in progress. If a build job is running, abort build job before attempting to open
chamber door.



To prevent eye injury, ultraviolet (UV) light inside the chamber will not operate when chamber door is open. When closed, the chamber door
keeps UV radiation from escaping. The chamber door remains locked if build job is paused.

04.0 Build Material Safety

Users of the modeler should be informed of potential hazards of part material prior to working with a modeler, or performing duties which may
result in exposure to uncured part material, such as removal and disposal of bin liners and empty cartridges, or waste bag.

Part Material
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4.1 Disposal

4.2 Health Hazards

4.3 Material Handling

4.4 Personal Protection Equipment
4.5 Regulatory Information

4.6 Spilled VisiJet® Material

4.7 Waste Removal

4.8 Material Storage

4.1 Disposal

Disposal of fully cured parts produced are not subject to regulations of any known agency worldwide. VisiJet® support material and cartridges
may be disposed of in ordinary office trash.

Uncured part material waste is classified as regulated, and in some areas hazardous, requiring special packaging, transportation, and disposal.
The disposal of partially cured or uncured model material must comply with all local, state, and federal environmental safety regulations.
Applicable part "waste" includes cartridges (empty or full) and waste bag. Any materials used cleaning up uncured part material should be

disposed of as uncured part material.
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To find out facility disposal requirements, contact a local waste disposal provider. (Local environmental regulatory agency should have a list of
qualified providers.) You will need to give disposal service provider a copy of the part material MSDS / SDS, and possibly other forms included in
the Appendix of your VisiJet® Material Handling Guide, such as Waste Profile Worksheet and SNUR (Significant New Use Regulation - U.S.
only). A report will be provided, indicating disposal requirements, as well as a quotation for regularly scheduled pickups. If assistance lis needed
locating a waste disposal provider, or completing a waste disposal form, contact local 3D Systems Technical Support Hotline.

3D Systems assumes no liability or responsibility for proper disposal of uncured part material. Proper disposal of uncured part material is the sole
responsibility of the user.

4.2 Health Hazards

Health Hazards

Uncured VisiJet® model material is a sensitizer. Skin or eye irritation could occur when exposed to the chemical composition of the
material.
ny chemical may exert harmful effects if contacts or enters the body. VisiJet® part material is a sensitizer and irritant.

Skin Sensitization

CAUTION: Uncured VisiJet® part material is a sensitizer. Skin or eye irritation could occur when exposed to the chemical composition
of the material.

Uncured material is a sensitizer, and can cause allergic reactions if contacts skin without protective gloves. Refer to personal protection
equipment for more information. To avoid sensitization, do not allow uncured material to contact skin. Consult the MSDS for specific information
about the sensitization potential.

Inhalation

Under normal operation, inhalation is not an expected route of entry.

Ingestion

CAUTION: Uncured VisiJet® model material is toxic if ingested.

Uncured material is toxic if ingested. Uncured material must not be present where food and drink are stored, prepared, or consumed and not
ingested. After handling modeler materials, wash hands with soap and water before consuming or preparing food.
Handling Finished Parts

Finished (cured) parts can be handled or disposed of the same as standard household plastic products. VisiJet® parts are not recyclable. VisiJet®
materials are not intended for, and cannot be used for medical implant, or food or drink handling applications.



Exposure control

The modeler has a variety of built-in engineering controls which are designed to prevent operator exposure. Do not try to change or disable these
controls.

disposable paper towels.

4.3 Material Handling

Emergency (MSDS)

Appropriate hygienic practices should be followed, including washing with soap and water before meals, breaks, smoking, applying cosmetics,
Chemtrec USA (800) 424-9300; Europe +1-703-527-3887
Packaging Inspection

using toilet facilities, and after work.

Employees should be alerted to the need to clean and rinse off any contacted surface promptly in order to prevent

further contamination. Ensure a convenient washroom location is provided with access to soap, water, and

VisiJet® material is packaged in cartridges. Eight cartridges are packaged in polybags, and placed in shipping

cartons. Upon receipt of material shipments, inspect cardboard carton exterior for signs of damage and leakage. If leakage is observed, DO
NOT open carton, and contact 3D Systems' Technical Support Hotline. If no leakage is observed, store materials in cartons until material is used.

Part Building

If uncured material is observed on the part or platform after build, this is an abnormal condition, and is an indication the modeler requires servicing
by 3D Systems. Assume any liquid or paste-like material is part material. Do not directly touch uncured part material without protective gloves.
Discontinue use of the modeler, pending service by a 3D Systems Technical Support Representative.

Flammability and Combustibility

Do not expose materials to heat at or above 230°F (110°C), flames, sparks, or any source of ignition. (Though the U.S. Department of
Transportation does not consider VisiJet materials a "flammability hazard," they do classify them "combustible" based on flash points.) For more
information on VisiJet material flash points and combustibility, see VisiJet® Material Handling and Post Processing Guide.

4.4 Personal Protection Equipment
b ¥ Exposure to uncured model material may occur; when removing and disposing of the bin liners containing spent
model material cartridges and waste bag. To prevent contact, wear chemically resistant protective gloves - nitrile

or neoprene gloves are recommended. Do not use Latex gloves.

In the event of a leak or spill of uncured part material, wear safety glasses with side shields to provide eye
protection




Because of the modeler's built in engineering controls, respiratory protection is not necessary during normal
operation. A NIOSH-approved (or equivalent) dust mask is recommended when dry sanding cured material parts.

4.5 Regulatory Information

Support material has no known regulatory requirements.

In the U.S., uncured material is subject to special EPA disposal regulations and record-keeping requirements. "Uncured VisiJet® material"
includes any model material cartridge (empty or full), and waste bag---about half of which is uncured model material. For complete disposal
regulation details, see Appendix in your Material Handling Guide.

In the U.S., you must keep the following disposal records for five years after the date of disposal:

® The quantity of model material received (new or "virgin").
®* The name and address of the shipping location (the "responsible party" - generally your waste disposal service provider).
® The quantity of model material shipped (disposed). For further information, see your Material Handling Guide.

For assistance, contact 3D Systems Technical Support.

4.6 Spilled VisiJet® Material

Spills of material are HIGHLY UNLIKELY, and should NOT occur in normal operation of the modeler. If a leak occurs, it is an indication of a
serious modeler malfunction.

The first priority is to protect users from inadvertently touching material. Spills of support material can be cleaned without use of protective gear,
and disposed of as office trash. Handling uncured part material requires use of gloves and other personnel protective equipment to ensure no
direct contact with uncured model material. If you don't know which material it is, assume it to be uncured model material, and handle accordingly
- with the recommended personal protective equipment.

Promptly remove spilled material, dispose of waste material, and cleanup materials per local regulatory requirements. Discontinue use of the
modeler, and contact 3D Systems Technical Support for a service visit to determine and repair the source of leakage.

Small spills of uncured liquid part material can be cleaned up using disposable towels, non-reusable rags, or absorbing materials such as
sawdust, clay, diatomaceous earth, or activated charcoal. If spilled material is hot (liquid), wait until cools and gels before wiping up. After wiping
up the spill, wipe surface with denatured or isopropyl alcohol and clean thoroughly with soap and water.

Consider avoiding placement of the modeler over carpeting, or consider use of barriers to avoid the possibility of carpet damage if spills were to
occur.

Advise service provider involved, of the spilled material, and provide MSDS and other material information prior to contact with the material.
Advise them of disposal requirements for model material and clean-up products if model material (uncured) is the spilled material. Use of heat
above 65°C (149°F) may prove helpful in removing spilled model material from carpet.

Tools contaminated with model material should be cleaned prior to reuse. Solvents such as denatured alcohol or Iso-Propyl Alcohol (IPA), are
normally required to clean equipment and tools. Wash with soap and water to remove any traces of excess model material or solvent. Contact
solvent suppliers for information on proper handling of solvents if used for clean-up.

4.7 Waste Removal

. CAUTION: Uncured model material is a sensitizer. Skin or eye irritation could occur when exposed to the chemical composition of the
material.

Wear protective gloves before removing any waste product from the modeler. Be careful not to spill, drop, or expose others to these materials -
particularly part material cartridges or waste bag. Dispose of all waste material appropriately per local regulatory requirements.

Remove support and modeling cartridges from the waste bins. if liners are contaminated with uncured modeling material, replace the liners.
Dispose of waste bag containing both support and uncured model material. Replace with new waste bag.



bin liners

4.8 Material Storage

BUILD MATERIAL SUPPORT MATERIAL

Shelf life for HR200, SR200,MP200, DP200- 2 yr Shelf life for S100- 5 yr

Shelf Life for CP200, CPX200- 5 yr Shelf Life for S200- 5 yr

Climate - Cool, dry area with adequate ventilation Climate - Cool, dry area with adequate ventilation
Temperature Range - 60°F (16°C) to 80°F (27°C) Temperature Range- 60°F (16°C)to 80°F (27°C)
Maximum Storage Temp - 95°F (35°C) Maximum Storage Temp - 95°F (35°C)

Environmental Conditions - No direct sunlight, heat, flames, or UV Environmental Conditions - No direct sunlight, heat, flames, or UV
energy. energy.

NOTE: For optimal results, keep stored cartons closed and sealed, and do not open polybags until cartridge is ready for use.
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Always check material "Best used by" date before loading cartridge. Do not load cartridges into modeler if about to expire. When modeler detects
an expired cartridge, it aborts the build and ejects the cartridge if date is past expiration date for support material or more than one year past the
expiration date for model material.
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Support (white) cartridges must be loaded in the left side feed slot. VisiJet part (black) cartridges must be loaded in the right side feed slot.
Before removing a cartridge from protective polybag and before loading into modeler, inspect the cartridge for signs of damage or leakage. Do not
load a damaged or leaking cartridge. Dispose of it according to local regulations.

05.0 System Requirements

Power Rating

Country Voltage Frequency Amps (A) Phase Power Cord

USA 100-127 VAC 60 Hz 15A 1 P/N 23417-802-XX
France 200-240 VAC 50 Hz 15A 1 P/N 23417-802-XX
Germany 200-240 VAC 50 Hz 15A 1 P/N 23417-802-XX
Hong Kong 200-240 VAC 50 Hz 15A 1 P/N 23417-802-XX
Italy 200-240 VAC 50 Hz 15A 1 P/N 23417-802-XX
Japan 100-127 VAC 60 Hz 15A 1 P/N 23417-802-XX
Switzerland 200-240 VAC 50 Hz 15A 1 P/N 23417-802-XX
United Kingdom | 200-240 VAC 50 Hz 15A 1 P/N 23417-802-XX

If connecting the modeler to a 200-240 VAC facility power outlet, connect the power cord (located
inside modeler's country kit)to the external transformer. Connect the transformer's power supply to the
facility's outlet.

06.0 Familiarization

The 3-D modeler system is a Multi-Jet-Modeling (MJM) line of modelers. The solid imaging modeler produces plastic prototype models from 3D
solid Computer-Aided Design (CAD) models and through the modeler client software. The models are generated in a rapid prototyping (RP)
environment. The primary features of the 3-D modeler are the user interface, build chamber, material feed slots, and waste material drawer. The
back of the modeler houses the power switch, internet and the power cord connections.
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The three dimensional solid models built by the modeler consist of two materials (support material and part material). The support material is a
wax based material providing adhesion to build platform, as well as, providing material used to produce supports required to build the model.
The part material used to build the models is an ultraviolet (UV) curable material. After a layer of material is deposited in the build chamber, the
part is exposed to a UV flashlamp. The UV energy is absorbed by the material converting a liquid model material to a solid polymer. When the
build is complete the model (consisting of the two materials) is adhered to the build platform by means of the support material.

Part Material
VisiJet® CPX200

Part Number. 1111111111
Batch. AA101700A

Best fused by. SEP 2012

NetWt. 5009

)
;

Support Material
VisiJet® S200

i
f
i
W o000 xx

The material delivery system consists of two vertical stacks referred to as "magazines.” The magazine on the left side of the machine holds nine
support material (white) cartridges. The right side of the machine holds up to nine part material (black) cartridges. The magazine system feeds
the cartridges to the modeler using a clamp feed system. As the cartridges are emptied, the clamp feed system releases the empty cartridge(s)
into the waste drawer. Material waste is generated by two processes; cleaning the printhead array plate and planarization. The cleaning process
involves purging jets and wiping the printhead array plate. Gravity pulls the waste material from the Head Maintenance Station (HMS) trough into

the waste umbilical. The combined waste material is then purged. The printhead cleaning process is invoked automatically prior to test print and
build jobs.




After the build is complete, the platform and the model is then removed from the modeler. A secondary operation, knows as finishing, is required
to provide a finished/cleaned model. Refer to your ProJet™ Finisher's Guide for more information.

6.1 System Functions

.Menus: Menu names and menu options are capitalized in boldface text. Instructions for selecting menu options look like this: "Select
Menu>Option." This means "select (click or highlight) the Menu, then select Option on the menu."

B client Manager - 3-D Modelers
File Wiew Help

Add 3-D Modeler Chrl+a

R

i projet invision invsion2 invision3 projet2 invisiond
Exit

d

Add a new 3-D Modeler 3D Systems, Inc.

Keys: Keyboard key names are capitalized; for example, "Press the Enter key."

Buttons: Command buttons on the modeler's user interface are in boldface upper case text; for example, "Press the ONLINE button." The
command buttons are: MENU, LIGHT, PAUSE, ONLINE, YES, NO, and ABORT.

Display Text: Text on the modeler's display appears in uppercase in this guide; for example, "When the display shows PAUSE JOB? Y/N, press
YES."

Display Panel
Chamber
IID
Light- On / Off Scroll Down
Online / Offline
Abort Job

Menu Options

Scroll Up

Confirm

Confirm
YES

07.0 Modeler Setup

To prepare and build part files, connect your PC and modeler to the network. For additional information refer to Facility Requirements Guide.

Component Type Software Requirements

PC Microsoft ® Windows® 98, Millennium Edition (Me), New Technology (NT) 4 (SP 3+), 2000, or XP.



7.1 Power on Modeler

7.2 Add Cartridge and Install Build Platform

7.3 Install and Run ProJet™ 3-D Modeling Client Software
7.4 Create STL File(s) to Build

7.5 Submit Test Build

7.6 Build Demo

7.1 Power on Modeler

WARNING: Read and follow safety guidelines in Electrical Safety. Ignoring these guidelines could result in death, bodily injury, or
modeler damage due to electrical shock or fire.

CAUTION: Verify modeler's rear panel power switch is OFF. Connecting power with switch on can damage modeler and cause
bodily injury or death due to sudden, unexpected mechanical motion.

1. Plug modeler power cord P/N 23417-802-XX into modeler's rear panel socket. Plug modeler power cord into a grounded power outlet.

NOTE:
A shielded Ethernet

cable is required when POWER

connecting from the | _ HH " SWITCH
modeler to the end
user’s computer.

POWER
CORD

2. I1f 200-240 VAC required, connect modeler power cord to external transformer in kit P/N 23418-801-XX, then plug transformer power cord into
a grounded power outlet.

3. Place switch on the rear of modeler to the ON position.
4. Wait 4 hours for modeler to warm up before pressing ONLINE to start a build job.

NOTE: = You can submit jobs to modeler while it is warming up.



7.2 Add Cartridge and Install Build Platform

Add Cartridge

Add material to feed slot when it has 3 cartridges or less. When a feed slot has 3 cartridges or less,
the operator panel displays ADD SUPPORT and/or ADD PART. Add 9 cartridges maximum per slot.

5 cartridges are visible when magazine feed slot is full.

NOTE: Before handling build material cartridges. Read Material Safety Data Sheet (MSDS).

1. Unpack cartridge and MSDS/SDS Sheet. Remove cartridge's from poly bag.

2. Open left and/or right magazine feed slot doors. Insert support material (white)
cartridges in left magazine feed slot. Insert model marterial (black) cartridges

in right magazine feed slot.

Support =
S Build

Matona Material
Side

3. Lower each cartridge into slot. Ensure flat of cartridge and label on cartridge
is facing upward. Add eight cartridges maximum to each slot.
Close both magazine feed doors.

NOTE: For proper operation of the feed system, a minimum of three (3) support and three (3)

build cartridges must be present.



Install Build Platform

NOTE: Clean platform using Isopropyl Alcohol before installing into modeler.

4. Open the chamber door.

5. Align platform's rear notch into
x-carriage's locating tab.

6. Align platform's front notch into
latch's front locating tab.

7. Press locking tab into the
notch to secure.

8. Close the chamber door and
press ONLINE.

7.3 Install and Run
ProJet™ 3-D
Modeling Client
Software

. . ; Online / Offline
NOTE: Before installing software, ensure network and PC meet Modeler Setup requi

1. Load the 3-D Modeling Client
Software from CD packaged
with the modeler accessories
kit. An autorun file on the CD will automatically load when CD is inserted into ROM drive of the computer. If installation program does
not start when loaded, select and run Setup.exe from the root directory of the ROM drive.

2. After successfully installing software, select Start from the Program menu and then select >3-D Modeling Client icon. The modeler
window appears.

E Client Manager - 3-D Modelers

File Yiew Help

=,

add modeler

3. Power up modeler as described in 7.1 Power on Modeler. Establish a network connection between modeler and PC.



Power
Switch

Ethernet
Connection

4. You can only submit build jobs to modelers having icons in the window. To create an icon for a modeler, click Add modeler icon (or
choose File > Add 3-D modeler), the Add Modeler window appears, prompting to choose the modeler's IP address from list of available

modelers.
E Client Manager - 3-D Modelers

File ‘iew Help

add madeler

5. Select the IP address for desired modeler, click OK. The client software prompts for a modeler name. After entering a name, an icon for
the modeler appears in the 3-D Modelers window. Once an icon for a modeler exists, click it to add files for a build job, preview a build
job, sumit a build job, or manage a build job in progress.



Add a 3-D Modeler 3

Enter 3-D Modeler IP address:

Available Modelers:

MName IP Address Type

< | 2

Refresh | Cancel

6. After the modeler is added, click on the icon in the 3-D modeler window or choose File > Open 3-D modeler to submit build jobs to the
modeler, or manage build jobs in it's queue. If the modeler icon has a red lightning bolt, your PC is hot communicating with the
modeler. Jobs cannot be submitted to the modeler until communication is restored.

Submit (%]

[ Job Mame: ]

Select Files... I Hemove Files 1 Options ... ]

Job Seale [%]:

I ame ] Extents D_‘_“‘
INZ2=3N2x05220n 12

C:MProgram Filezh30 Spztem...

Copies:

|

2 [ Preparation Orly

Presview... ] | Subrnit | Cancel I

UHD mode is cumently selected. Click Options to change.

7.4 Create STL File(s) to Build

The modeler builds 3-D models from files using industry-standard .STL (STereoLithography) format. Most popular 3-D modeling CAD software
packages can save files in STL format. Sample STL files are in the \3-D Modeling Client\Samples folder.



Click the Submit Icon

Click the Select Files...

Double Click on Sample.stl file

| End Time

<

For Help,

x| @k E

|~

Preyiew

Y|

File name: ISample,stl Open I IV File Preview
Files of type: |STL Files [*.stl) :] Cancel

7.5 Submit Test Build

It is recommended to submit a Test Build prior to each build job to ensure part quality.
Press MENU, scroll to highlight TEST BUILD.

Display Panel
Chamber
Light- On / Off Scroll Down
Online / Offline
Abort Job
Menu Options
Scroll Up

Confirm

Confirm
YES

Press YES. The message PLATFORM CLEAR DOOR CLOSED? Y/N scrolls across the display. # Press YES if the platform is clear and the
door is closed, otherwise press NO.



7.6 Build Demo

1. Press MENU, scroll to highlight BUILD DEMO. # Press YES on Operators panel; the system displays PLATFORM CLEAR? Y/N.
2. When platform is clear, press YES. The modeler starts demo build job.

Display Panel
Chamber
Scroll D
Light- On / Off croll Down
Online / Offline

Abort Job

Menu Options

Scroll Up

Confirm
YES

08.0 Operations

This section provides information on Previewing, Saving, Submitting, and Managing modeling jobs through the modeler's operator panel menu
and 3-D Modeling Client Software. In addition this section describes how to remove the build platform, how to empty the waste drawer and how
to shut down the modeler.

NOTE Make certain the modeler is Off-Line during the job submittal process. Place the modeler on-line after the job is submitted.

8.10 Shrink Compensation for ProJet VisiJet® Materials
8.1 Preview Build Job
8.2 Save a Build Job
8.3 Submit a Build Job
® 8.3.1 Remove Build Platform
® 8.4 Manage Build Jobs
® 8.4.1 Delete Build Jobs
® 8.4.2 Pause Build Job
® 8.4.3 Abort Build Job
® 8.4.4 Repeat Build Job
8.5 Modeler Status
8.6 Empty Waste Drawer
8.7 Shutdown Modeler
8.8 Remove Part from Build Platform
8.9 3D Modeling Batch Submission for Production Environment

8.1 Preview Build Job

Preview Screen Icon Description
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Preview build job before submitting.



Preview jobs before submitting them to the modeler.

1. Click the Preview button on the Client's Submit dialog box. At least one part must be added for build in the Submit dialog box before you
are able to preview.

—
Submit |£|
[~ Job Mame:; I
Select Files... | Hemove Files i Options ... |
I Job Sczale [%]:
M ame Extents
I vI 25
C:AProgram Filesh3D Spstem... 3112« 31120522 in |
Copies:
=
< Al I ' [ Preparation Only
Preswvig. .. | | Subrnit I Cancel |
| IIHD mode iz cunrently zelected. Click Dptions to change.

2. Highlight a Job Name in modeler's Info window, click the Preview button or choose Job > Preview. The print preview window will open
as shown below.

¥ charltonb@us-ws-3157-0007 - ProJet Print Preview
File Edit Yiew Tools Help

B[] [ S/%5/55 fls| KR OB Glssli|e|elsy €|e|w||e]@]
w[EIEe| 8|5/ @6 8|6|0|6|ElE]8:(68.

For Help, press F1 ProJet CPX XHD 3D Systems, Inc. /|

3. If the file you are trying to preview is beyond the threshold of a certain file size, the system will display one of the following two messages.

This message is displayed if the file size of the individual part is larger than 100 MB, (1,000,000 triangles).



3D Modeling Client :

' [rLarge_Part,stl has more than 1000000 triangles.
e In order to achieve the best performance, display bounding box only?

This message is displayed if the accumulated file size of multiple parts exceeds 300 MB, (6,000,000 triangles).

3D Modeling Client :

' Toktal number of triangles is more than 6000000,
. In order to achiewve the best performance, display bounding box only?

If you click Yes, the system will automatically switch to the Bounding Box Display. The Bounding Box Display only displays the
bounding extents of a given geometry and does not try to resolve the triangles required to display an entire geometry. This is
demonstrated in the figures below which show the conventional Shaded Display on the left and a Bounding Box Display on the right.

57-0007 - ProJet Print Preview.

Hebp
85| [6 3[55) 0 AR 0|6 6se|ile|e|ss €lelv|v|e|o|A
SEIEID | 8]0 0|0 8|68|0]|6|6|6)85:/8)

8% A% OB &ilsE|0|e|&(% <|e|v|V||DH[w
SEIEQ| 8|5]6 o0 8|6|6|5|6|E(8/88)

For Heb, press F1 Prodet CPXXHD_30 Systems, Inc. For telp, press 1 ProJet CPYYHD._3D Systems, Inc.

Shaded Display Bounding Box Display

It is not mandatory to switch to Bounding Box Display. However, doing so will allow Print Preview the ability to load more parts into a
single build envelope. The user can also access the Bounding Box Display manually via the "Views" toolbar, by clicking on the "Bounding
Box Display" icon.
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8.2 Save a Build Job

Prepare and save build job(s) on your PC. Later, submit the job, skipping preparation steps. A saved job is specific to a single PC and can only
be built or deleted from that PC.

1. Click a modeler's icon in 3-D modelers window to open modeler's Info window.

B Client Manager - 3-D Modelers [:__I@”z‘
File View Help
Open 3-D Modeler Chrl+0

= (=5 =) ~
Remove 3-0 Mo Chrl+D E@ % % % Em

Create Shortcut ; 3
R projet invision invsion2 invision3 projet2 invision4 3
Exit 1

Add a new 3-D Modeler

“i Plastic ProJet - Info

| End Time

[~ Job Name: [« defaul

SelectFlles...I Flerw:vu‘»:‘Fl\eil Options ... |

<

For Help,

File name:  [Sample.stl IV File Preview
Files of type: ISTL Files [*.st) Zl Cancel |

2. Select Job name to be saved. A

3. Choose Job > Default Options.




Default Job Options

; _ Shrink. Comp [%)
[ SaveVerfied STL file vl 000
¥ Enable Part Placement
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4. In the Default Job Options, select Save Job, then click OK.

NOTE: Jobs to modelers' queue cannot be saved unless Save Job was selected. When a build job with the Save Job option enabled
reaches Pending status, another job (with the suffix "_s") is added to the queue. For more information see Saving, Repeat,
and Confirming Build Jobs in your ProJet Client online Help for more information.

8.3 Submit a Build Job

1. Click on modeler's icon in the modeler's window. The modeler's Info window opens.
B Client Manager - 3-D Modelers [Z||EE|
File Wew Help

uz-ws-3048

add modeler 2Imu

For Help, press F1 30 Systems, Inc,

2. In modeler's Info window, click Submit to open Submit dialog box.

‘& ProJet - Info

File Modeler Job View Help
Submit o
l z|%| olelele| @

Bt | [ Job Status [ Buid Time | Start Time [ End Time
johnzond@us-ws-0880-0011 Printing 1116 Tue, Mar 18, 2008 02:51 PM Wed, Mar 19, 2008 03:43
pursleyp(@us-ws-0717-0007 Previewing 0300 e e
< ! 2

Submit & job "ProJet"; Printing Tue, Mar 18, 2008 04:33:46 PM ProJet HD 3000 3D

3. Click Select Files on the Submit dialog box to add one or more parts to the build job. NOTE: More than one STL file can be selected
at atime. In Select CAD Files dialog box, hold down the Ctrl key and click on several STL files. Add parts in Preview window. After you
have added at least one STL file, use Preview window to view build jobs in three dimensions, and to add more STL files if desired.



Sample STL files are in the \3-D Modeling Client\Samplesfolder.
Click the Submit Icon

Click the Select Files...

Double Click on Sample.stl file

‘& Plastic ProJet - Info

| End Time

g | Options ...

< ~ - @ekE-

For Help,

|~

Preview

uHg

File name: ISampIe.slI Open I IV File Preview
Files of type:  [STL Files (%st]) ~| Cancel |
A

4. Browse files in Select CAD files window. When files are selected, file names appear in build job parts list of Submit dialog box.

5. Click Options...button on Submit dialog box. The Default Job Options dialog box appears.

Default Job Options r>_<|

v i B — Shrink Comp [%]—
[ Save Verfied STL file
¥ Enable Part Placement

- 0.00

[ Savelob Y w

[ Quick Build Qrientation > [~ 0.0

[ Shareable :

¥ Ulra High Defirition [UHD] - Urits —
&+ |nch

BuildShyle: I'-xf::t:c:-'_ci Columns __\_! O mm

F I Rezet | Cancel

6. Change or reset values, such as Build Style, Shrink Comp (%), and Units. (See "Default Job Options Dialog Box" in the 3-D Modeling
Client online Help for job options definitions.)

Parts shrink in X and Y. The degree of shrinkage depends on part geometry. To improve part accuracy, apply the X, Y, and Z Shrink
Comp (%) values then measure your parts and refine these values. Refer to 8.10 Shrink Compensation for ProJet VisiJet® Materials.

7. Click Preview on Submit dialog box. If the file you are trying to preview is beyond the threshold of a certain file size, the system will
automatically access the Bounding Box Display feature. See Section 8.1 Preview Build Job for details.
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Submit X]
[ Job Mame: I
Select Files... | HemoveFiles I Options ... |
I Job Scale [%]:
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| IJHD mode iz cunrently selected. Click Dptions to change.

8. Manipulate parts interactively in the Preview window's virtual modeler 3-D build workspace.

“¥ pursleyp@us-ws-0717-0001 - 3-D Modeler Preview 9(=(t3
File Edit View Tools Help

Bl%| 6f5 W= Bl% A% 08| cfsn|e|ele €lelv|v|wlo|a &

|| |a e o e Tl ale
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&

For Help, press F1 Prolet UHD \SD Systems, Inc, /|

9. If required, resize all parts in build job by the same scale factor, enter a Job Scale % in the Submit dialog box before clicking Submit. To
resize some of the parts of your job, use Edit > Scale in Preview. (See the topic "Previewing Print Jobs > Scaling Parts" in your ProJet
Client online Help for instructions.)



NOTE Applying Job Scale % (or scale percentage(s) using Edit > Scale in Preview)) is different than applying Shrink Comp % values
in the Default Job Options dialog box. Applying scale percentages changes "nominal” part dimensions in the STL file(s).
Applying Shrink Comp percentages does not change nominal part dimensions in the STL file(s). Rather, Shrink Comp adjusts
for expected shrinkage during the build so the actual final part dimensions more closely match the nominal dimensions.

Scale Selected Parts

¥ lsometric Scale 1m0

b e £

Matice: Input zcale value relative ta the arignal model.

Apply ‘

10. See Section 8.1 Preview Build Job.

11. Click Submit on Submit dialog box if you did not preview the job, or click Submit toolbar button in the Preview window if you did preview

the job.
Submit [X]

[~ Job Mame: ]
Select Files... I Remove Files ] Options ... I
] Job Seale [%]:
M ame Extents
v] 25
C:AProgram Filesh30 Sestern.. 3112 #3112 20522 in |
Copies:
=] 1
=t
< | 2 [ Preparation Only
Presview... I | Subrmnit | Cancel I
UHD mode i= u:'ﬁr'réntl_;,l selected. Click i':Ii:u'tiiﬁ-ns' ta Ehangie.-

Both the 3-D Modeling Client and Print Preview now check to make sure that the maximum allowable accumulated build file size on the
machine is not exceeded during job submission. The maximum threshold for job submission is roughly two gigabytes or 40,000,000
triangles. If a User attempts to submit a job to the build queue that exceeds this threshold, the following message will be displayed.

Submit Job

The tokal number of triangles is 40982940 and over the modeler's capability (40000000 kriangles), Job can not be submitted

12. The build job submitted will be built when modeler is ready unless:
® |tis OFFLINE, in which case press the ONLINE button on the modeler's panel.



Display Panel

Chamber

Scroll D
Light- On / Off crofl Bown

Online / Offline

Abort Job

Menu Options

Scroll Up

Confirm Co;}firm
YES °

® |t does not have a clean build platform installed; install clean one and press ONLINE.
® The Preparation Only option in the Submit dialog box was checked. This causes the modeler to wait until the build job was
confirmed before building --- enabling you to change the job in the Preview window again before confirming.

NOTE See "Checking modeler Status" and "Confirming Build Jobs" in the online Help for more information.

13. When the Operator panel LCD shows PLATFORM EMPTY? Y/N, verify platform is clean and free of debris. If required, press NO and
remove build platform from the modeler to replace.

NOTE:  Prior to installing a build platform verify both sides of platform and x-carriage mating surface are free and clear of debris.

14. Open chamber door and carefully position rear of clean platform onto X-carriage under tab on back of X-carriage.
\

15. Lower platform onto X-carriage. While holding onto platform tabs close latch. Ensure latch clicks.

16. Close chamber door and press ONLINE. When the Operator panel LCD shows PLATFORM EMPTY? Y/N, press YES. If the display
shows please empty waste or next build will exceed waste capacity, open the waste drawer and dispose of waste material.

17. Close waste drawer. The job starts automatically.



NOTE ' If the display shows WAITING FOR JOB, no jobs are in the modeler's queue. Go back to Step 2 and submit a build job to the
queue. Once in the queue, the job starts automatically.

18. Refer to Manage build jobs for additional information.

8.3.1 Remove Build Platform

When operator panel display shows *DONE: <job_name> remove build. Hold X-carriage when removing platform from modeler to prevent damge
of sensors.

1. Open chamber door.
2. Open latch securing build platform by pressing inward and releasing.
3. Lift up build platform and pull out, then install a clean platform or close chamber door.

8.4 Manage Build Jobs



The client software will not send build jobs to the modeler until job confirmed by selecting Preparation Only checkbox on Submit dialog box or
resubmit a saved build job.

Submit X

[ Job Mame: ] default:

Select Files... ] Hemove Files j Cptions ... ]

Job Sczale [%]:

M ame 1 Extents ]:v]_"'ﬁl‘ﬂ'
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Cancel ]

[ UHD mode is cumently selected. Click Options to change.

1. Click modeler's icon in client software to open modeler's Info window.

B client Manager - 3-D Modelers
File Wew Help

e ;@;J_|
=

add modeler zimu

5

uz-we-3048

For Help, press Fl |30 Systems, Inc.

2. Select build job with Job Status of Needs Confirm or Saved.

3. Click Confirm button or choose Job > Confirm located on the tool bar of the modeler window.

& ProJet - Info B@@
Fle Modeler Job View Help

8l¢] 412/ elolelo] @

Jab Name | Job Status | Build Time | Star Time | End Time

johnsond@us-ws-0880-0011 Printing 10:59 Tue, Mar 18, 2008 0251 PM ‘Wed, Mar 19, 2008 0349
purslepp@us-ws-0717-0007 Previewing 000 e e

¢ | b
|For Help, press F1 "ProJet"; Printing  Tue, Mar 18, 2008 04:50:42 PM ProJet HD 3000 3D




4. Click Yes. Job is sent to modeler as soon as it's available.

L] ': Do o wank to submit alivermi@us-ws-3048-0006 ko projet 7
L.,

A Needs Confirm build job status immediately changes to Pending when confirmed.

NOTE Confirming saved jobs generates a Pending build job whose name lacks the "_s" suffix. However, saved jobs remain in the queue.

8.4.1 Delete Build Jobs
8.4.2 Pause Build Job
8.4.3 Abort Build Job

8.4.4 Repeat Build Job

8.4.1 Delete Build Jobs

Follow the instructions below to delete one or more jobs from the queue after you submitted.

1. Click on modeler's icon in modelers window to open Info window.

B Client Manager - 3-D Modelers
File Wew Help

=,

add miodeler zimu

P

uz-wg-3048

Faor Help, press F1 3D Syskems, Inc.

2. Select build job(s) to delete. (Ctrl-click to select several jobs.)

% ProJet - Info g@@
File Modeler Job  View Help

b2 S|%|%| 0|8]¢
Job Name | Job Status | Build Time | Start Time | End Time
johnsond@us-ws-0880-0011 Printing 10:59 Tue, Mar 18, 2008 0251 PM Wed, Mar 19, 2008 03:49
pursleypl@ius-ws-0717-0007 Previewing 0300 e e

< | >
Far Help, press F1 "Prolet"; Printing Tue, Mar 18, 2008 04:50:42 PM |Prolet HD 3000 3D

3. Click Delete or Delete All button or choose Job > Delete or > Delete All.



Delete
Delete All

& ProJet - Info

File Modeler \lob\ Yiew Help

bl 5/5%] olelelel 0|
Job Name | Jab Status | Build Time | Start Time | End Time
ohnsond@us-ws-0880-0011 Printing 10:59 Tue, Mar 18, 2008 0251 PM Wed, Mar 19, 2008 03:43

pursleyp@us-ws-0717-0007 Previewing o e e

¢ | ?

For Help, press F1 "ProJet"; Printing | Tue, Mar 18, 2008 04;50:42 PM ProJet HD 3000 3D

4. To delete all jobs, click the Delete All button or choose Job > Delete All. If you use Delete All, and there are saved jobs, the ProJet
Client will ask you if you want to delete saved jobs as well as other ones.

"j Job "olivermi@us-ws-30458-0006" needs canfirmation,

e Delete This Job 7

If you delete a job that is currently building; this aborts the operation. However, the job status will continue to show as "Building" at the PC
until deletion is confirmed at the modeler.

8.4.2 Pause Build Job

® Press PAUSE. When display shows PAUSE jOB? Y/N, press YES to pause building or NO to keep building.



Display Panel

Chamber
Light- On / Off

Scroll Down
Online / Offline

Abort Job

Menu Options

Scroll Up

® The modeler keeps building after pressing PAUSE while it displays PAUSE jOB? Y/N. If YES was pressed in response to PAUSE JOB?
YIN, the modeler completes current layer or its current task. Then moves the platform forward while chamber door and waste drawer
remain locked. Press PAUSE again to resume paused job. If you don't press PAUSE again, the paused job resumes automatically after
5 minutes.

® |f you press NO in response to PAUSE JOB? Y/N, the job does not pause and the confirmation prompt disappears.

8.4.3 Abort Build Job

Press ABORT.

When display shows ABORT JOB? - Y/N, press YES to abort the build job or NO to continue. The modeler keeps building after you press
ABORT while it displays ABORT JOB? - Y/N. If you press YES in response to ABORT JOB? - Y/N, the modeler does the following:

® Stops building immediately.
® Displays waiting for DSP (Digital Signal Procesor) done.

NOTE: Abort does not finish the current layer or current task.

Displays Finishing Build while it cures any uncured material on the platform.
Displays Raising Printhead as it raises the printhead.

Moves the platform forward and unlocks the chamber door.

Displays:

abort: <job_name>

remove print



Display Panel

Chamber

D
Light- On / Off Scroll Down

Online / Offline

Abort Job

Menu Options

Scroll Up

If you press NO in response to ABORT JOB? - Y/N, the job does not abort and the confirmation prompt disappears.

You can now remove the platform.

8.4.4 Repeat Build Job

NOTE: Do not select Repeat from the Operators Panel after a test print.

1. Press MENU, scroll to highlight REPEAT BUILD. # Press YES; the system displays PLATFORM CLEAR? Y/N.
2. When platform is clear, press YES. The modeler repeats the previous build job.



Display Panel

Chamber
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Light- On / Off croll Down
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Abort Job

Menu Options
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8.5 Modeler Status

To view the status of the modeler, observe the Liquid Crystal Display (LCD) Panel located on the user interface for elapsed build time, Build time
remaining, material information, job status, name, time remaining on build, error messages, and System Statistics.

Display Panel

8.6 Empty Waste Drawer



Personal protection equipment is required before opening waste drawer. Follow all material handling and disposal guidelines. Always
ollow MSDS guidelines and local regulations regarding handling and disposal of regulated materials. Keep disposal records if local
law requires.

1. Open waste drawer.

Remove disposable bin liners with cartridges. Dispose of bin liners and cartridges.

2. If full, remove, close, and properly dispose of waste bag.

3. Install new waste bag onto bracket. Tilt bracket with waste bag and install flag into slot in back of waste drawer. Ensure bracket is
properly seated on mouting bracket. Install new bin liners.

4. Close waste drawer and press ONLINE to resume.

8.7 Shutdown Modeler

WARNING: Switching off or disconnecting the modeler's power without going through a shutdown process can severely
damage the modeler. Always perform shutdown procedures before switching off modeler's power unless power must be
disconnected immediately for safety reasons.

The modeler can take several hours to warm up after being shutdown and switched off. Before shutdown and switching off, verify no need to build
parts again soon.

Mode Clamp Feed
Standby 15 Min.
Conserve 25 Min.

Initial Pwr =~ 90 Min.
Up



NOTE: It is recommended to leave your modeler in either standby or conserve mode instead of shutting down if the modeler is to be used

within 7 to 10 days of last build.

After modeler is idle 2 hours or 72 hours, it enters Standby or Conserve mode, respectively. In these energy-saving states, the modeler's heaters
are partially cooled and many other components are disabled. The heaters are cooler in Conserve mode more than Standby mode. It takes much

less time for the modeler to warm up from Standby or Conserve mode than it does from full shutdown/power off. Warming up from Conserve
mode takes more time than from Standby.

NOTE To increase or decrease wait time before the modeler enters Standby mode or Conserve mode, contact 3D Systems Technical
Support.

1. Verify modeler is not building.
2. Abort current build job.

3. Press MENU, scroll to highlight SHUTDOWN.

LCD Display Sl Up
Light o off
Menu options
Pause job L Onlire JOfline
Abartjoh Scroll Lip

CorfirmYES Confirm KO

4. Press YES twice.

5. When the display shows OK TO POWER OFF XXX, press the power switch on the rear panel.



Power

Switch
Power
Ethernet Cord
Connection

NOTE: To halt shutdown, press ONLINE before you press the power switch.

8.8 Remove Part from Build Platform

Remove build platform from modeler. Refer to Manage build Jobs.

® Place warm platform of parts in a freezer for a few minutes. As the parts and platform cool, they contract at different rates and separate.
® Alternatively, the parts can be mechanically separated from the build platform by force using a tool such as a thin blade.

8.9 3D Modeling Batch Submission for Production Environment

The Modeler Batch Processor allows users to prepare/send jobs and inquire job status for multiple 3D modelers across networks without using 3D
Modeling Accelerator Client software, which requires human interactions. It is compatible with various 3D Systems' supported 3D Printers,
including ProJet, InVision, and ThermoJet.

The ModelerBatch.exe application reads the job parameters from the given parameter file (.ini file), then prepares, packs and sends the jobs to a

designated printer. The ModelerStatus.exe application allows the user to inquire the job status on a designated printer for both current and
previous jobs including "printing", "pending", "completed", and "aborted".

Modeler Batch Processing

Setting Job Parameters via INI File

Before running the ModelerBatch.exe, a text file must be created that specifies the desired parameters for the pending job. See example below:



B sample.ini - Notepad

Ble Edt Format Yiew Help

[10B PROFPERTIES]
IP Address = 000.000. 000,000
mumber of Parts = 4

Partl =C: stimodel rartl.st]
Part2 =C:'stimodel \Part2.stl
Part3 =C:\stimMmodelwrart3.stl
Partd =C:'stimMmodel rart4.stl
Auta Part Placement = NoO

Max Extent X = 70.00
csharable = yves

quick Build = no

pual Mode UHMD=Yes

verify = No

shrink Factor =0

chrink Factor ¥ = 0
shrink Factor Z = 0
Support Style = Standard
Units = tmm

Job scale %= 100,00
Wumber of Copies = 1
Save Job = MO
cave verified STL

Y

MO

[10B PREPARE]
wait Timeout=3600
Dizplay Error Msg = Yes

Ln 1, Col I

All the job parameters are categorized into two sections:

® Job Properties
® Job Prepare

The table below provides a description of the ModelerBatch INI parameters.

Parameter Default Description Section
Name Value Name
IP Address N/A IP address of the designated modeler, e.g., 192.168.0.2 or 192.168.000.002 Job
Properties
Number of 0 Total number of parts in the job Job
Parts Properties
Part# N/A Full path and name of the STL/CTL file. # must be replaced with numbers which start from 1, Job
e.g., Partl, Part2, and Part3 ... The total number of parts must be consistent with the total number Properties
of parts.

If a file name is one of:
Modeler_Verification_Strip.STL
Modeler_Verification_Strip_InVision.STL
Modeler_Verification_Strip_ProJet.STL
Modeler_Verification_Strip_ProJetCPX.STL
...then the file is the verficiation strip.

Auto Part No Valid values are "Yes" or "No". Job
Placement If Yes, the Batch Processor performs auto part placement. Properties
If No, the parts will not be auto placed.
However, the users should ensure the part sizes and positions are appropriate.

Max Extent X dPlatExtX = Max job volume X extent, which is used to position the verification strip for optimal build speed. Job
The default value is the max platform X extent, which is 6 inches for ProJet 3000 in high resolution = Properties
mode.



Sharable No Valid values are "Yes" or "No", which specify if the print job will be shared with other jobs in the Job
printer. Properties
The print job will not be shared if this field is absent.

Quick Build No Valid values are "Yes" or "No", which denote whether the parts should be oriented in the printer to Job
save print time. Properties
Quick build part placement will not be performed if this field is absent.

Dual Mode Yes Valid values are "Yes" or "No", which specify if ultra high resolution (UHD) mode is used to build the = Job

UHD parts. Properties
UHD will be used if this field is absent.
This option is only valid for the modelers with dual-mode capability.

Verify No Valid values are "Yes" or "No", which specify if verify needs to be performed on the parts. Job
Verify will not be performed if this field is absent. Properties
Shrink Factor X = 0.0 The corresponding shrinkage compensation factors desired in percentage. Job
Shrink Factor Y These fields will default to O if absent, which means no shrinkage compensation is added. Properties
Shrink Factor Z
Supports Style  Standard | This key defines the type of supports desired. Job
The Standard supports type will be used if this field is absent. Properties

Valid values are Standard, Vertical Columns, Universal Std, or Universal HiRes.

Units Inch This key defines the units for the job. Job
The units will default to Inch if this field is absent. Properties
Valid values are Inch or mm.

Job Scale % 100.0 The key indicates the scaling desired for the print job. Job

The scale will default to 100% if this field is absent. Properties
Number of 1 This key defines the number of copies of the specified parts in the list. Job
Copies The default is to created one copy for each part in the job. Properties
Save Job No The key is used to specify whether the job is to be saved in addition to printing. Job

The job will not be saved if this field is absent. Properties

Valid values are Yes or No.
Save Verified No The key is used to specify whether the verified STL is to be saved in the same folder of the STL file = Job
STL using the name STLFileName_v.stl. Properties
The verified STL will not be saved if this field is absent. Valid values are Yes or No.
Wait Timeout 3600 The key denotes the allowed wait time to send jobs from the client to the modeler. Job
The wait time depends on the client computer and network speeds. Prepare
If the wait is more than the allowed wait timeout, the ModelerBatch.exe will be aborted.
The default allowed wait timeout is 3600 seconds (or 60 minutes).

Display Error Yes The key denotes whether to display an error message dialog (i.e. - Pop-up message) if any error Job
Message happens. Prepare

Running the application
The ModelerBatch.exe application can be invoked from command line or program. The command line format is as follows:
RootDir\bin\ModelerBatch.exe IniFile ReportFile

Descriptions:
RootDir - the installation folder of the ProJet client, which can be obtained from the registry by using:

Key = "HKEY_LOCAL_MACHINE\SOFTWARE\3D Systems\3D Modeling Accelerator"
Name= "RootDir"

ReportFile - returns a report to a specified file on the job submission

Note: If a filename is not specified for the report file, the data will be written to a default file named ReportFile.txt. This file will be overwritten every
time the modelerbatch.exe or modelerstatus.exe applications are run without a report file specified

The DOS window show below is an example of running the ModelerBatch.exe via command window.



WINDOWS\system32\cmd. exe

Microsoft Windows HP [Uersion 5.1.26801]
{C» Copyright 1985-20P1 Microsoft Corp.

G:\>C:\"Program Files\3D Systems\3D Modeling AcceleratorsBin\Modeler Batch.exe” G:nSt1ModelsSanple_ini C:\St1Model\Sample.txt_

Note: If any of the directories specified in the command script have folders with spaces in the folder name quotes will required around the
directory structure for the script to work. If no spaces are present, the quotes are unnecessary.

Example: "C:\Program Files\3D Modeling Accelerator\Bin\ModelerBatch.exe"

Output Report

After a successful run of the modelerbatch.exe application, the job will be submitted to the designated modeler's build queue and the application
will output a report (ReportFile or IniFile) to the location designated in the command script. The figure below is an example of the report output
after the ModelerBatch.exe completion.

£ Sample.ixt - Notepad
File Edit Format Miew Help

[INI FILE]

Status=Mo Errors

[FRINTER]

Status=0ffline

[JOB PROPERTIES]

IF Address=000, 000, 000, 000
[10E - 1ok Mame herel]
Status=rPending

Ln1, Cal1

Modeler Status Reporting

Setting up Status INI File

Before running the ModelerStatus.exe, a text file must be created that specifies the desired machine. See example below.

£ Sample.ini - Notepad

File Edit Format Miew Help

[J0OE PROFERTIES]
IP Address=000.000.000. 000

[10E - {10k Wame Herel]
[J0BE - {JobZ2 Mame Herelr]|

Ln 5, Caol 25




The table below provides a description of the ModelerStatus INI parameters.

Section Name = Parameter Default Description
Name Value
JOB IP Address N/A IP address of the designated modeler, e.g., 192.168.0.2 or 192.168.000.002
PROPERTIES
JOB - N/A N/A The job names are not necessary to request current modeler status.
JobName However, individual job status will only be returned to the output ReportFile if the job names are

specified in the INI file.
The job name is formatted as "JOB - username@ComputerName-####", where ####

represents the 4-digit job number.

Running the application

The ModelerStatus.exe application can be invoked from command line or program. The command line format is as follows:
RootDir\bin\ModelerStatus.exe IniFile ReportFile

Descriptions:
RootDir - the installation folder of the ProJet client, which can be obtained from the registry by using:

Key = "HKEY_LOCAL_MACHINE\SOFTWARE\3D Systems\3D Modeling Accelerator"
Name="RootDir"

ReportFile - returns a report to a specified file on the job submission

Note: If a filename is not specified for the report file, the data will be written to a default file named ReportFile.txt. This file will be overwritten every
time the modelerbatch.exe or modelerstatus.exe applications are run without a report file specified.

The DOS window show below is an example of running the Modelerstatus.exe via command window.

WINDOWS\system32\cmd. exe

Microsoft Windows XP [Uersion 5.1.26801
(C> Copyright 1985-2881 Microsoft Corp.

C:\8t1Model~Status.ini C:“\St1Model\Status.txt

G~ >C:in"Program Files\3D Systems“\3D Modeling ficceleratorBin\Mode ler Status.exe’

Output Report

After a successful run of the modelerstatus.exe application, the application will output a report (ReportFile or IniFile) to the location designated in
the command script. See example below.



B status.txt - Notepad

File Edit Format Wiew Help

[FRINTER] ~
Status=Printing 3
Current Job={Job MWame Herel}

[12B - {Job Mame Herel}]

Status=Printing

Sstart Time=Mon, oct 26, 2009 05:15 aAM

End Time=mon, Oct 26, 2009 04:30 PM

Total Build Time=00:15

remaining Build Time=07:00

complete %=2 F
Mumber of Parts=5

Ln &, Col 23

If building in UHD Mode, "Number of Parts" includes the Verification Strip in the part total.

After a machine is put "Online", there is a period of time that a job takes to initialize. During that time, the Status returned will be "Not Printing" and
the End Time, Total Build Time and Remaining Build Time will all report "Not Estimated". Once the state changes to "Printing", these values will
be reported accurately.

Exit Error Codes

The Modeler Batch Processing applications including ModelerBatch.exe and ModelerStatus.exe will return exit error codes if there are any issues
while the application is running. The following table gives a description of each possible error code that may be reported while running either

application.

Exit Error
Code

0

500
501
502
503
504
505

506

507

508

509

510

511

Error Description

No Error

The iniFile is not specified for batch processing

The specified iniFile does not exist or cannot be opened

IP Address field not present

IP address cannot be validated
Number of Parts field does not present
STL file for Part# can not be found

Communication error. Unknown modeler type or
unconnectable modeler.

Verification Strip file cannot be found.

Wait timeout.

Cannot connect to the modeler.

Part outside platform or exceed platform size

Too much part data for Auto Part Placement or Quick
Build Placement

Suggested Solution

Specify the parameter IniFile as the argument

Please make sure the IniFile exist

Add the IP address

Check the IP address

The number of parts must be specified and larger than 0.
Missing the STL file. Make sure it exists and accessible.

Please check IP address.

Reinstall the client or restore the verification strip files.

Please verify the network and increase the wait timeout in the
IniFile.

Please check IP address.

Check the size and position of all parts to ensure that they will fit
inside the platform

Please not use Auto Part Placement or Quick Build.
For example, use Print Preview and manually position the
gemetries.



8.10 Shrink Compensation for ProJet VisiJet® Materials

Material shrinkage occurs in thermoplastics as they transition from liquid state to solid state during the curing process.

The ProJet Accelerator Client Software has features that allow the user to compensate for the natural shrinkage of the material in order to fine
tune the accuracy of a part.

These shrink compensation values serve as general guidelines to setting shrink compensation. Part building and cleaning in a controlled process
will best determine the optimal shrink compensation values for a particular geometry.

SHRINK COMPENSATION VALUES FOR VISIJET® PART MATERIALS

Material Xvalue Yvalue Zvalue
SR200 (Configuration A)  1.01% | 1.01%  0.00%
HR200 (Configuration A 1.01% 1.01%  0.00%
EX200 (Configuration A)  1.01 0.75 0.00
EX200 (Configuration B) = 0.50 0.25 0.00
DP200 1.01% 1.01%  0.00%

MP200 1.01 0.75 0.00

1. Enter Standard Shrink Compensation Values for the material.
a. Open ProJet Accelerator Client software and select the desired modeler.
b. Select the model to build.
c. Select the "Options" button.
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d. Within the Options panel, enter shrink compensations values for X or Y. Z compensation is rarely necessary (see table above for the values).*
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2. Identify the exact X and Y dimensions of the part using a CAD program.
a. Most CAD programs and simple stl file viewers will provide a way to view a part with its dimensions.
b. Make note of the actual X and Y dimensions as XCAD and YCAD.



3. Build and clean the part and take measurements of the finished part.

a. It is recommended to measure along the critical dimensions of the geometry, take measurements in multiple areas and take an average of
the values.

b. Measurements can be made using calipers or more advanced metrology methods.

c. Make note of the X and Y dimensions of the printed part and mark them as XPART and YPART

NOTE: If the measurement of the finished part is different from the measurements of the CAD model, fine tune the accuracy using
scaling factors.

4. Determine "Scaling Factor" to use for the next build
a. Use the following formula calculate the scaling percentage to be used on the “fine tuning” build:

X Scaling Factor = (XCAD - XPART)/ XCAD * 100 (answer will be as a percentage)

Y Scaling Factor = (YCAD - YPART)/ YCAD * 100 (answer will be as a percentage)

EXAMPLE:

X measurement of CAD model = 3.000"

Y measurement of CAD model = 5.000"

X measurement of printed part = 2.998"

Y measurement of printed part = 4.989"

X Scaling Factor = (3.000 — 2.998)/3.000 *100 = 0.067%

Y Scaling Factor = (5.000 — 4.989)/5.000 * 100 = 0.22%

5. Enter "Scaling Factor" for adjustment build
a. Open ProJet Accelerator Client software and select the desired printer.
b. Select the model to print
c. Open Print Preview to view the model. Select the model (color should be yellow)
d. Select the "Scale" Icon and enter the dialog box to enter the above scaling factors.
e. Uncheck the "Isometric Scale" button. This allows user to make individual x and y adjustments.
f. In the example above the x scaling factor should be 100% + 0.067% = 100.067%
d. The y scaling factor should be 100% + 0.22% = 100.22%
e. Enter these two numbers in the corresponding scaling boxes for x and y.
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6. Build Part with Scaling Factors and measure
a. Additional iterations of adjusting scaling factors and taking measurements may be necessary with certain geometries.

09.0 Maintenance

The following general maintenance procedures provided must be accomplished to help maintain high part yield and low modeler down time.

® 9.1 Cleaning Surfaces

® 9.2 Cleaning the Waste Drawer
® 9.3 Preventive Maintenance

® 9.4 Return Modeler for Repair



9.1 Cleaning Surfaces

* Do not remove any outer panels when cleaning the modeler. Panels must only be removed by qualified 3D Systems Technical Support
Representatives.

1. Remove dust from outer surfaces of modeler(s) wiping with a clean, dry, lint-free cloth.
NOTE Dust and clean outside surfaces only. Do not dust inside build chamber or feed slots.
2. Remove dirt and grease from modeler(s) outer surface by spraying all-purpose cleaner on a clean cloth and gently wiping.
Caution: Use only non-abrasive, alcohol-free cleaners to clean surfaces. Do not use all-purpose cleaners

containing petroleum-based polishing agents such as liquid wax. Spray cleaner on cloth, not on surface. Do not
use cleaning solvents on build chamber window do to damage of protective UV coating.

3. Remove dirt, grease, and build material residue from operator panel buttons, display window, and feed slot door windows using a
ammonia-based glass cleaner on a clean, lint-free cloth gently wiping the buttons and windows.

* Remove build platform before cleaning the operator panel buttons. This will prevent the modeler from initiating any actions when buttons
are pressed.

9.2 Cleaning the Waste Drawer

Review VisiJet material handling and disposal safety guidelines in Build Material Safety section of this guide before cleaning the waste drawer.
Clean modeler's waste drawer as follows:

1. Verify modeler is OFFLINE.
2. Put on protective gloves. Refer to Personal Protection Equipment.

3. Open waste drawer. Remove white bin liner, black bin liner, and waste bag.



4. Dispose of bin liners and waste bag if required. Refer to Disposal.
NOTE ' Insure to reinstall waste bag bracket in correct orientation; with flag in slot at rear of waste drawer.

5. Gently scrape any material stuck onto interior surface of waste drawer bins. Use a flexible plastic scraper to avoid damaging the paint.

6. Vacuum inside waste drawer material bins to remove scrapings.
7. Wipe inside surfaces of waste drawer bins using a clean cloth and all-purpose spray cleaner.

9.3 Preventive Maintenance

Preventive maintenance must be performed by qualified 3D Systems Technical Support Representatives after either one year of total build time,
or consuming 208 Ib (94 kg) of build and support materials combined.

The modeler automatically tracks total build time and combined weight of material consumed to date. When either the time or weight limit

mentioned above is reached, its LCD panel will prompt you to contact 3D Systems Technical Support to schedule a PM visit. When prompted,
schedule PM as soon as possible in keeping with the terms of your 3-D modeler warranty.

9.4 Return Modeler for Repair

Guidelines for repacking the modeler
When shipping the modeler for service or repair, use the original shipping carton and packing material. Shipping damage as a result of inadequate

packing is your responsibility. If you have already disposed of the packing material, contact 3D Systems Customer Support for information on
repacking the modeler.

10.0 Error Messages



There are three primary types of error messages which could appear on the operator display panel of your modeler. The primary types of error
messages found will be Build, Material, and 10.3 Status and Message Lines.

Display Panel

® 10.1 Build Messages
® 10.2 Material Messages
® 10.3 Status and Message Lines

10.1 Build Messages

Use these messages to help you manage print jobs before, during, and after printing. The causes of and actions to take in response to various
messages are described in the following table:

MESSAGE CAUSE ACTION
XXXXK b XXXX T The modeler is currently building. None
SUPPORT....7 PART The display shows the elapsed and remaining build time on the top line and the
PRINTING number of cartridges in the each feed slot on the second line.

NOTE

Add material when the number of cartridges in a slot is 3 or less.

NOT BUILDING The modeler is ready to build. Press ONLINE to build or
MENU to list menu options.
ProJet™ [X.X] month dd When modeler is initially powered-up the latest version of software is briefly None
yYYYTIME XX: XX: XX displayed.
NOTE

This is the ProJet modeler's control code version; not the ProJet
Client software version.

10.2 Material Messages

Use the following messages to help manage build jobs before, during, and after building. The causes and actions to take to various messages are
described below:

MESSAGE CAUSE ACTION



#X PART  The current number of black model ("part”) None
material cartridges in the right feed slot.
#X The current number of white support material None
SUPPORT | cartridges in the left feed slot.
ADD The maximum number of model material Add model material cartridges.
PART cartridges in the right feed slot is 9. The feed slot is full when five cartridges are visible in the window (maximum
number of cartridges per slot is 9). Add cartridges as requried.
ADD The maximum number of support material Add support material cartridges.
SUPPORT | cartridges in the left feed slot is 9. The feed slot is full when five cartridges are visible in the window. Add

cartridges as required.

10.3 Status and Message Lines

Messages appear either on the Status line or the Message line. Read both lines together to determine the exact state of the modeler. The Status
line generally indicates current state of the modeler. The Message line shows the action to take to complete a function and move to the next step.

MESSAGE

ABORT

ABORT
ACKNOWLEDGED

BUILD PAUSED

CLEANING
PRINTHEAD

CLOSE DOORS

CONFIRM
PLATFORM
CLEAR OR
CANCEL

PRESS PAUSE
TO CONTINUE

CYCLE POWER
TO CONTINUE

DONE REMOVE
BUILD

HOMING
PRINTHEAD

HOMING X - Y

CAUSE

ABORT button pressed. Refer to abort build job.

You confirmed an abort command. The modeler is
aborting the current job.

PAUSE button pressed during the build. The build
platform moves forward and the chamber door
and waste drawer remain locked. When you press
the PAUSE button during a build, the modeler
completes its current task before stopping.

The modeler is cleaning the build jets.

The chamber door is open.

The modeler is prompting you to verify the
platform is clean and clear of obstructions. Refer
to installation of build platform.

The modeler is paused.

A severe error occurred. The modeler cannot
recover from it and must be switched off.

The modeler completed building the current job.

The modeler is initializing the Z-axis prior to
building.

The modeler is initializing the X-axis and Y-axis
prior to building.

ACTION

Press YES to abort
or NO to cancel the
command.

None.
Refer to abort build
job.

Press PAUSE to
continue. Refer to
pause build job.

None. (This occurs
automatically before
every build.)

Close the chamber
door.

Verify the platform is
clean and clear, then
press YES to
continue or press
ABORT to cancel.

Press PAUSE to
continue or ABORT
to cancel.

Cycle power to the
modeler. If the error
message occurs
again, contact your
Technical Support
Hotline.

Remove the
platform. Refer to
removal of build
platform.

None.

None.



INSTALL
PLATFORM

NOT BUILDING

OK TO POWER
OFF

ONLINE/MENU?

PAUSE
ACKNOWLEDGE

PLEASE WAIT

PRE-JOB
CHECKS

BUILDING

RAISING
PRINTHEAD

REMOVE BUILD

SHUTDOWN IN
PROGRESS

SHUTDOWN
COMPLETE

STANDBY

The modeler cannot detect a platform.

The modeler is ready to build.

The modeler completed its internal shutdown
procedure and is ready to be shutdown.
Refer to modeler shutdown.

The modeler is ready to build.

The PAUSE button was pressed. The modeler is
acknowledging and complying with the command.

The modeler is cooling to shutdown temperature.

Briefly displayed during modeler build preparation.

The modeler is currently building.

The modeler is raising the printhead so you can
remove the platform.

The modeler completed a build job and unlocked
the chamber door so you can remove the platform.

You selected the SHUTDOWN menu option, then
pressed YES twice. The modeler is cooling down
so power can be switched off. Refer to modeler
shutdown.

Modeler cooldown is complete; modeler is ready
for power off.

The modeler is in energy-saver mode. All internal
subsystems are partially cooled and the modeler
is inactive.

Install a clean
platform. Refer to
installation of build
platform.

Press ONLINE to
build or MENU to list
menu options.

Toggle power switch = NOTE
on modeler rear
panel to the OFF

position.

Press ONLINE to
build, MENU to list
menu selections.

None. NOTE

Wait for the modeler
to complete its
shutdown
procedures. Refer to
modeler shutdown.

None.

Allow the build job to
continue or press
PAUSE or ABORT
to stop building.

None.

Remove the platform
and replace it with a
clean platform.
Refer to removal of
build platform.

None. DO NOT
switch off the

modeler while
shutdown is in
progress.

Wait for OK TO
POWER OFF
message, then
switch power off at
the modeler's rear
panel.

None.

The modeler will
warm to operating
temperature when
you press any button
or submit a build job.

NOTE:

Before you switch power off, verify
you will not need to build parts
again soon. It can take several
hours for the modeler to warm up
after you switch power back on.

If you press PAUSE during a print
job, the current layer or process is
completed before the pause takes
effect.

icon=false}Before you switch power
off, verify you will not need to build
parts again soon. It can take
several hours for the modeler to
warm up after you switch power
back on. Refer to modeler
shutdown.
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WAITING FOR
JOB

WARMING STAGE
[4,3,2,1]

The modeler is online, but there is no build job in
it's queue. The modeler is ready to build as soon
as it receives a job.

The material heaters and printhead jet heaters
gradually warm up to either standby or build
temperature.

Submit a build job to
the modeler. Refer
to submit a build job.

None.
The numbers on the
LCD panel count

down as the modeler
warms up.

At Warming Stage 1
, all heaters and
material are at build
temperature.

11.0 Troubleshooting

If problems occur with the modeler, error messages appear on the LCD of the Operator's panel. Refer to appropriate troubleshooting table for
assistance. There may be times when an unrecoverable error message will appear and will require a call to Technical Support Hotline. Prior to
contacting Technical Support Hotline ensure you have serial number of the modeler, a brief description of the problem including exact error
message displayed on the LCD panel, and when the problem occurred (while submitting a job, during the beginning or end of the build, after
power off recovery, etc.).

Display Panel

Chamber

11 D
Light- On / Off Scroll Down

Online / Offline

Abort Job

Menu Options

Scroll Up

Confirm Confirm
YES °

11.1 Communication Errors

11.2 Head Maintenance Station Errors

11.3 Material Feed and Waste System Errors
11.4 Material Quality Guarantee Errors

11.5 Material Waste Errors

11.6 Motion System Errors

11.7 UV Subsystem Errors

11.8 Vacuum Regulator Errors

11.9 Power Outage

11.1 Communication Errors

MESSAGE CAUSE ACTION
RT_ERROR: No machine = No network Ensure you have a valid network connection. Cycle power to the modeler. If error
Identification (ID) connection. message occurs again, contact your Technical Support Hotline.

A communication
error occurred.

Cycle power to the modeler. If this does not restore communication, contact your
Technical Support Hotline.

evm6x_hpi_open()

A communication
error occurred.

Cycle power to the modeler. If this does not restore communication, contact your
Technical Support Hotline

evme6x_init_emif()



11.2 Head Maintenance Station Errors

MESSAGE CAUSE

HMS ERROR
Recovery

An error occurred during printhead maintenance (cleaning
the printhead before beginning a build).

ACTION

11.3 Material Feed and Waste System Errors

Cycle power to the modeler. If error message occurs again,
contact your Technical Support Hotline.

A just loaded cartridge did not engage correctly during the material feed cycle or the printhead sensors did not detect the required material level.

MESSAGE

RT_ERROR: AirPurge 1
(or 2) Not Responding

RT_ERROR: AirPurge 1
(or 2) Position Error

RT_ERROR: AirPurge 1
(or 2) Position Error

Material 1 (or 2) Index
Dump Error

Material 1 (or 2) Index
Load Error

Material 1 (or 2) Index
feed Error

Material 1 (or 2) Index
Timeout Error

RT_ERROR: Index
Drum 1 (or 2) Temp Out
of Range

RT_ERROR: material
feed 1 (or 2) can't fill
head

Material 1 (or 2) Pump
Retract Error

Material 1 (or 2) Pump
Engage Error

CAUSE

Fault detected in control circuitry.

Fault detected in control circuitry.

Fault detected in control circuitry.

Feedback did not indicate whether the indexer reached the
specified position.

Feedback did not indicate whether the indexer reached the
specified position.

Feedback did not indicate whether the indexer reached the
specified position.

Communication failed to report the indexing operation was
completed

Possible faulty heaters.

A just loaded cartridge did not engage correctly during the material
feed cycle or the printhead sensors did not detect the required
material level.

The retracting plunger was not detected.

A new cartridge has been indexed but did not satisfy the sensors.

11.4 Material Quality Guarantee Errors

MESSAGE

Support (or build)
material cartridge
not detected

CAUSE

Modeler is out of material cartridges, a cartridge
misfed, or the material identification system is faulty.

ACTION

ACTION

Cycle power to the modeler. If error message
occurs again, contact your Techncial Support
Hotline.

Cycle power to the modeler. If error message
occurs again, contact your Techncial Support
Hotline.

Cycle power to the modeler. If error message
occurs again, contact your Techncial Support
Hotline.

Contact your Technical Support Hotline.

Contact your Technical Support Hotline.

Contact your Technical Support Hotline.

Contact your Technical Support Hotline.

Cycle power to the modeler.
If error message occurs again, contact your
Technical Support Hotline.

Cycle power to the modeler.
If error message occurs again, contact your
Technical Support Hotline.

Contact your Technical Support Hotline.

Contact your Technical Support Hotline.

The build will abort if it needs to use the questionable cartridge
to finish the build.

® Add the specified material cartridge, install a clean
build platform and repeat the build job.

® |f error message occurs again, contact your Technical
Support Hotline.



Support (or build) A cold cartridge was added to the material feed slot The build will abort if it needs to use the questionable cartridge
material cartridge and it did not have enough time to melt before the to finish the build.

not melted modeler requested material.

® |nstall a clean build platform and repeat the build job
after the modeler has reached build temperature.

® |f error message occurs again, contact your Technical
Support Hotline.

Support (or build) The material identification system detected expired Follow the discard instructions posted to the LCD panel.

material cartridge material.
expired

Support (or build) A material cartridge was inserted into the wrong feed = The build will abort if it needs to use the questionable cartridge

material cartridge slot.
incorrect type

11.5 Material Waste Errors

MESSAGE CAUSE

RT_ERROR: draintank not Fault detected in control
responding circuitry.

RT_ERROR: Draintank Fault detected in control
Position error circuitry.

RT_ERROR: Draintank Fault detected in control
timeout error circuitry.

RT_ERROR: can't empty Sensor or valve
draintank malfunctioned.

11.6 Motion System Errors

MESSAGE  CAUSE

X-Following = An attempt to open the build chamber door
ERROR was made, or position sensor errors occurred.

Negative Variations in scanning axis velocity.
Firing

Delay

Pause Position sensor contamination.

Timeout
ERROR

11.7 UV Subsystem Errors

MESSAGE CAUSE ACTION

to finish the build.

® Follow the discard instructions posted to the LCD
panel.

® |f error message occurs again and you have inserted
the correct material cartridge into the correct feed slot,
contact your Technical Support Hotline.

ACTION

Cycle power to the modeler. If error message occurs again, contact your
Technical Support Hotline.

Cycle power to the modeler. If error message occurs again, contact your
Techncial Support Hotline.

Cycle power to the modeler. If error message occurs again, contact your
Techncial Support Hotline.

Cycle power to the modeler. If error message occurs again, contact your
Techncial Support Hotline.

ACTION

Ensure the build chamber door is secured, then cycle power to the modeler. If
error message occurs again, contact your Techncial Support Hotline.

Cycle power to the modeler. If error message occurs again, contact your

Technical Support Hotline.

Cycle power to the modeler. If error message occurs again, contact your
Technical Support Hotline.



RT_ERROR: UV UV sensor Cycle power to the modeler. If error message occurs again, contact your Techncial Support

Lamp Power Too detected a Hotline.
Low possible fault.

CAUTION
o prevent skin exposure to uncured model material, do not handle parts in

a build without wearing gloves if a UV lamp problem occurred during the

build.
11.8 Vacuum Regulator Errors
MESSAGE CAUSE ACTION
RT_ERROR: Printhead Indicates a fault within the Cycle power to the modeler. If error message occurs again, contact your
Vacuum Low vacuum system. Techncial Support Hotline.
RT_ERROR: Printhead Indicates a fault within the Cycle power to the modeler. If error message occurs again, contact your
Vacuum High vacuum system. Techncial Support Hotline.

11.9 Power Outage

If you are present during a power outage, or discover the main power OFF, complete the following steps:

1. Switch power OFF on modeler's rear panel so it does not automatically start when power is restored. This prevents modeler damage due
to power flickers and surges.

Power
Switch
Power
Ethemnet Cord
Connection

2. When power is restored and stable, switch modeler power ON on the rear panel.
If power outage occurs and is restored before anyone can take action, the modeler will recover as follows:

The modeler advances through warming stages until reaching the required build temperatures. If modeler was not building when power outage
occurred, the top line on the LCD panel will display "Not Building" and bottom line will display "Online/Menu?". The modeler is ready to

accept a build job.



If modeler was building when the power outage occurred, the LCD panel will display "Power Off Recovery" after power is restored and modeler
has reached build temperature. This safety feature prevents accessing incomplete build until all build conditions are satisfied. Once occurred, the
job will end, the LCD panel will display "Done Remove Build" and the build platform will move forward, and can be removed and repeat build job
if desired.

NOTE ' If the modeler is in Power Off Recovery, the build chamber will not be able to open until modeler completes recovery.

12.0 Finishing

When the build is complete, refer to the VisiJet® Material Handling and Post-Processing Guide for information on how to detach parts from build
platform, remove support material from parts, and clean parts to a smooth finish.
Basic part coating and equipment maintenance recommendations are also included.

13.0 Projet™ Spare Parts List

® 13.1 Consumables and Replacement Modules

13.1 Consumables and Replacement Modules

To view the parts and modules that are available, click on the Projet™ Spare Parts Locator.

14.0 Other Documents

14.1 Parts Finisher User Guide

14.2 Material Safety Data Sheets (MSDS)

14.3 Projet™ Quick Reference Guide

14.4 Facility Requirements Guide

14.5 VisiJet® Material Handling and Post-Processing Guide

14.1 Parts Finisher User Guide

When the build is complete, refer to the Parts Finisher Guide for information to detach parts from build platform, remove support material from
parts, and clean parts to a smooth finish.
Basic part coating and equipment maintenance recommendations are also included.

14.2 Material Safety Data Sheets (MSDS)

To obtain a copy of the Material Safety Data Sheet (MSDS) or a Safety Data Sheet (SDS), go to 3D Systems website. . . 3D Systems MSDS

14.3 Projet™ Quick Reference Guide

PROJET 3-D Modelers Quick_Reference Guide.pdf

14.4 Facility Requirements Guide

Projet™ 3-D Modelers Facility Requirements Guide
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14.5 VisiJet® Material Handling and Post-Processing Guide

VisiJet® Material Handling and Post-Processing Guide

15.0 Service and Support

® 15.1 Contacts
® 15.2 How to Order Parts

15.1 Contacts

For information, questions, or comments about ProJet™ 3-D modeler system(s), VisiJet® materials, or request service, please contact a
3D Systems Customer Service or Sales Representative nearest you.

3D Systems

333 Three D Systems Circle
Rock Hill, SC 29730 USA

tel: 803.326.4080

fax: 803.324.8810

toll free: 800.889.2964

email: moreinfo@3dsystems.com
www.3dsystems.com

Nasdaq: TDSC

Customer Support Hotline
U.S.A. 800.889.2964
Asia-Pacific (+852) 29 23 50 77
Europe (+49) 6151 357-0

Sales and Service

FRANCE tel (+33) 1 69 35 17 17 ITALY tel (+39) 039 68904 00
GERMANY tel (+49) 6151 357-0 JAPAN tel (+81) 3 5451-1690
HONG KONG tel (+852) 29 2350 77 UK tel (+44) 1442 282 600

SWITZERLAND tel (+41) 26 439 95 90

15.2 How to Order Parts

New and refurbished parts made by 3D System's manufacturer are used when performing warranty repairs and in building replacement parts and
systems. Refurbished parts and systems, are parts or systems that have been returned to 3D Systems, some of which were never used by a
customer. All parts and systems are inspected and tested for quality. Replacement parts and systems are covered for the remaining period of the
limited warranty for the product you bought. 3D Systems owns all parts removed from repaired products.

To order replacement parts, contact 3D Systems Customer Service Support or contact your local reseller.

When contacting 3D Systems Customer Service Support, have your modeler serial number available to give to customer support.

16.0 Online Help

« Find Help topics on the Content Pages of each section.

16.1 Frequently Asked Questions (FAQ)
16.2 Getting Help

16.3 Build Material

16.4 Modeler Hardware and Installation
16.5 Facility Requirements
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16.1 Frequently Asked Questions (FAQ)

General

What is rapid prototyping?

Rapid prototyping(RP)is the process of building a part from a 3D Cad drawing and converting the drawing format into an .STL file. When the
modeling event takes place in the modeler, it is constructed layer by layer using Accura VisiJet® materials.

What is 3D Modeling?

A type of rapid prototyping, typically defined by faster, more affordable, and easier-to-use technologies.

How does 3D Modeling fit into the design process?

For a growing segment of designers using 3D CAD drawing, the ProJet Modeler is quickly becoming an essential extension of overall CAD
systems and a critical part of the entire design process by:

® Accelerating Time to Market - through shortening design and development cycles and ultimately get products to market more quickly
enabling users to easily fine tune design and explore multiple design configurations.

® Generating Savings - by helping companies significantly lower production costs and reducing expensive revisions late in the development
cycle.

® Enhancing Communication and Collaboration - through bringing ideas off flat screens and producing functional 3D models that can be
easily shared, critiqued, and improved upon.

® Creating Better Designs - designers are no longer limited to the number of models they can produce and test, resulting in more creative
designs and better final products.

® Ensuring Confidentiality - eliminating the need to exchange confidential design files with service providers, allowing companies to
maintain product confidentiality and control.

How does the 3D modeling process work?

The modeler builds functional 3D models from the bottom up, one layer at a time.

STL files are imported into the modeler that automatically slices and orients the parts and creates any necessary support structures. The
materials are fed into the modeler in a heated semi-liquid state and accurately deposited in layers upon the build platform. After completion of the
build, support structures are simply removed through a post curing process.

How durable are the build material?

VisiJet® materials create accurate, detailed, and durable models from your 3-D CAD designs. Popular applications include concept models,
casting forms, prototype parts, and specialty tools. All the specific physical and process characteristics of VisiJet materials are detailed in
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VisiJet® Material Specifications

Is post-processing required?
Yes, upon removing the part from the modeler you will need to remove the support material from VisiJet® parts. The parts finisher makes

removing bulk support material from VisiJet parts efficient and easy. Forced airflow and precision temperature control deliver faster, shorter, and
more predictable VisiJet part finishing times.

Are there any special facility requirements or operating systems necessary to install and operate the modeler?

Refer to the ProJet™ 3-D Modelers Facility Requirements Guide.

Can more than one user process files and build parts?

Multiple users can send files to the modeler build queue, move, delete, and set build priorities in the build queue. Depending on the size of the
model, multiple files can be added onto the build platform in one build application.

Can models be sanded, painted, dyed, and glued?



The parts can be sanded to remove imperfections or layer lines from the surface. After priming, the parts can be painted using any oil- or
water-based paint that is compatible with the primer, or you can dye VisiJet parts with candle-craft dyes. You can also use super glue to join parts
together.

What is Computer-aided design (CAD)?

Computer-aided design (CAD) is use of a wide range of computerbased tools that assist engineers, architects and other design professions in
their design activities. It is the main geometry authoring tool within the Product Lifecycle Management process and involves both software and
sometimes special-purpose hardware.

What is a .STL file?

A .stl file is a format used by Stereolithography software to generate information needed to produce 3D models on Stereolithography machines. It
is a triangular representation of a 3-D object. The surface of the object is broken into a logical series of triangles. These triangles represent the
surface of the object.

How do | export an STL file from my 3-D CAD program?

Most CAD software offers STL conversion add-ins.

Are the build platforms reusable?

Yes the build platforms are reusable.

How many builds can one material cartridge produce?

This depends on the size and the complexity of the part being built.

If material runs out before the model has completed the build process, does the build abort?

Yes the build will be aborted. Ensure that there is sufficeint amount of materials to complete the build.

When submitting a build, will the 3-d modeling client software inform me if the amount of material is sufficient for
completing a build?

The client software will tell you how many cartridges it will take to complete the build.

How do | order parts?

To order replacement parts you will need to contact 3D Systems' Customer Support.

16.2 Getting Help

This section provides quick access to operating, maintenance, troubleshooting, spare parts locator and contact information to 3D Systems
Customer Support Centers.

® Projet Spare Parts Locator
® Material Safety Documentation, 3D Systems MSDS
® Contact 3D Systems Corporation

16.3 Build Material

Build Material Safety Guidelines

Material Disposal
Material Handling
Material Safety
Material Usage
Spilled VisiJet Material
Waste Removal

16.4 Modeler Hardware and Installation

This section describes the modeler setup appications and functions.


http://www.3dsystems.com/company/contact.asp
http://www.3dsystems.com/services/materials/index.asp

Client Hardware & Network Interface
Electrical

® Electrical Safety

® General Safety Guidelines
Ultraviolet (UV) Safety
Unpacking Modeler
Network and System Setup
Installing Material Cartridge
Installing & Removing Build Platform
Build Process & Previewing Build
Modeler Status
Abort Build
Part Removal
Shutting Down System
Notification Messages
Return Modeler for Repair

16.5 Facility Requirements

The requirements for electrical and room preparation are specified in the Projet™ 3000 Facility Requirements Guide.

17.0 Glossary of Terms

Build Platform - this part is used by the modeler to build parts. Support structures link the model to the build platform and must be removed from
the modeler once complete.

.stl File -- is a 3-dimensional solid Computer-aided design (CAD) software system used to produce models.

Material Quailty Guarantee - the modeler reads an encrypted RFID tag on the cartridge to communicate parameters and ensure optimum build
quality.

Chamber Door - the chamber door prevents harmful UV radiation from escaping the build chamber during the build process. The chamber door
must be closed prior to starting or resuming a build job and is locked when a build is in progress.

Modeling - the modeler uses cartridges and a build platform to create 3-dimensional plastic prototype models.
Operator Panel - is used to display build job status, menu options, and command prompts for the modeler.

Support Material - is a wax based material that provides adhesion to the build paltform and support for down facing surfaces and open volumes
within the model.

Build Material - is a paste-like acrylic compound that is an ultraviolet (UV) curable material.
ProJet Client Software - is used to setup, run, and manage build jobs.

Shrink Comparison Percentage (Shrink Comp %) - is used to adjust for expected shrinkage during the build so actual part dimensions more
closely match actual dimensions.

Job Scale Percentage (Job Scale %) - is used to resize parts during the build process.

Material Feed Slots - stores and feeds the cartridges to the modeler during the build process. The material feed slots hold eight each support
and build material cartridges.

Waste Material - is any uncured support and/or build material generated during a build process.

Debug Log - is a text file used for obtaining information for resolving potential problems that may occur with the modeler.
X-Axis - is the orientation of the part from front to rear on the build platform.

Y-Axis - is the orientation of the part from left to right on the build platform.

Z-Axis - is the orientation of the part height on the build platform.

Post Curing (Finishing) - is the final process to remove support material from parts and clean the parts to a smooth finish prior to surface finishing
and coating.


http://3dpedia.3dsystems.com/pages/viewpage.action?pageId=30703626
http://3dpedia.3dsystems.com/pages/viewpage.action?pageId=30703626
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